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Description of problem 

 The Arkansas Highway and Transportation Department (AHTD) as well as other 

state and federal agencies are required to identify and evaluate cultural resources that will 

be impacted by various kinds of projects addressed under Section 106 of the National 

Historic Preservation Act of 1966. Cultural resources include prehistoric and historic 

archeological sites as well as extant historic properties. Arkansas agencies must 

determine if such properties exist in their project right-of-way and consult with the State 

Historic Preservation Office (SHPO) in the Department of Arkansas Heritage (DAH) 

about the significance of those properties. By law, the SHPO consults with the Arkansas 

Archeological Survey (AAS) concerning archeological sites.  

The AAS maintains information on archeological sites, and projects conducted to 

locate and investigate sites, in the AMASDA (Automated Management of Archeological 

Site Data in Arkansas) computerized database system. The AMASDA system contains 

information on more than 40,000 prehistoric and historic sites and more than 5,100 

archeological projects. The AMASDA system presently consists of two Oracle databases 
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(Site Files and Projects), linked to a statewide Geographic Information System (GIS) that 

provides environmental context for archeological sites and project areas. These 

applications run on a Sun Enterprise 450 server.  

At present, AHTD personnel can search only the Site Files database via FTP 

(there is no way at present to search the databases remotely via the World Wide Web), 

and information retrieved from those searches cannot be imported directly into other 

software applications (for example, other databases, spreadsheets, GIS applications, etc.). 

The AAS Registrar’s Office must search the Projects database and then send the results 

of those searches to AHTD via email or through other channels. Nor is other information 

(archeological site form images, radiocarbon assays, and bibliographic citations) 

available to AHTD personnel online. Consequently, most AHTD staff skip the online 

searches and, on a daily basis, make telephone requests for information to the AAS 

Registrar’s Office which then executes the searches on a time-available basis. This is not 

a particularly efficient system. Consequently, the AAS and the AHTD are working on 

other cooperative initiatives to provide access to the Site Files, Projects, and Site Form 

Images databases. 

This project was designed to add new databases to the AMASDA system 

containing additional information required for comprehensive environmental reviews. 

Subsequent to the completion of this project, we hope to provide AHTD access to the 

new databases via the World Wide Web. The long-term goal of all of these projects is to 

enable AHTD personnel to search all AMASDA databases within a single, integrated 

framework that supports information retrieval in formats that can be imported directly 

into other applications. This will provide the AHTD and other agencies better access to 
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archeological information in the early planning stages of a project, thus reducing the cost 

of environmental review and subsequent regulatory delays. 

Approach 

 The immediate goals of this project were to add five new databases to the 

AMASDA system.  

Revisions and updates to two work-in-progress databases—Radiocarbon Assays 

and Citations—were completed. The Radiocarbon database, containing information on 

radiocarbon (carbon-14) determinations for sites in Arkansas, was updated to include 

information on 520 reports. The Citations database, containing bibliographic references 

to more than 8,800 archeological publications and reports for Arkansas and the mid-

South region, was also brought up to date. The information contained in both databases is 

frequently required for determinations of site significance in terms of criteria for 

inclusion within the National Register of Historic Places. 

Next, three new databases were created: 1) photographic images of archeological 

sites; 2) photographic images of representative artifacts from sites; and 3) illustrated text 

descriptions of over 200 archeological cultural phases/study units in Arkansas. Again, 

these databases provide information frequently required for determination of site 

significance. 

Finally, we developed a web application to provide access to information from all 

five of these databases within a single, integrated platform. When linked to the Internet, 

this application should significantly improve the environmental review process mandated 

for the AHTD and other agencies under Section 106 of the National Historic Preservation 

Act of 1966 and related legislation. 
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Methodology 

 Procedures for accomplishing the AMASDA system upgrades are described in 

this section. 

1. Archeological Site and Artifact Images Photographic Databases 

Images for the Archeological Site Images and Artifact Images databases were 

obtained from ten AAS research stations and from the University of Arkansas Museum 

Collection. Each station archeologist submitted up to 1000 slides of their choosing to the 

Coordinating Office for scanning. Slides received from the stations included images of 

archeological sites as well as images of representative artifacts from excavated sites. 

From March 2003 through May 2005 graduate students scanned these slides at the 

Coordinating Office in Fayetteville, using a Nikon Super Coolscan 4000 ED 35mm slide 

scanner. A scanning log (Slide_Log.xls) was filled out for each batch of slides to be 

scanned, and the scanning software (Nikon Scan 3.1) was adjusted to default values. The 

default values are: an output size of roughly 5.6 inches by 3.82 inches (with an end result 

of 5 x 3 after cropping), a resolution of 300 pixels/inch, and a file size of around 5.5 

megabytes. The slides were then scanned, using the SF-200 slide feeder adapter, in 

batches and named according to a standard convention used by all AAS research stations. 

Data for each slide was entered into a Microsoft Access database as the slides were 

scanned and images were cropped and rotated (if applicable) in Adobe Photoshop. 

In all, 7877 slides were scanned and entered into the database. Database fields 

include: slide name, file name tiff, file name jpg, year, site number, site name, site area, 

county, state, project name, sponsor, contractor, conference, people, names of people, 
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landscape, excavation, burial, artifact(s) formal photos, illustration, historic structure, 

rock art, comments, image record, date recorded, database recorder, and date entered. 

As part of this project, two manuals were created: 1) slide scanning protocol; 2) 

guide for entering data into slide scanning database. These manuals are provided as 

Appendices A & B. 

In addition to the Slide Scanning Database, a second database was developed 

specifically for slides housed at the AAS Coordinating Office in Fayetteville. From May 

2003 through December 2005, Dr. Charles McGimsey III and Mary McGimsey 

volunteered their time (750+ hours) to record data from over 14,000 slides. Each slide 

was carefully reviewed and detailed information including site numbers, site names, and 

content of the slide (people, landscape, excavation/testing, burials, artifacts, historic 

structures, illustration, maps, drawings, and/or type of rock art) was recorded on data 

entry forms. Information from these data forms has been entered into a second Microsoft 

Access database. The detailed information contained in this database will allow very 

specific searches of the Survey’s slide resources. 

2. Study Units Database 

Study units include time periods, cultural phases, and other constructs used by 

archeologists to evaluate and interpret archeological sites. Over 200 study units have 

been identified for Arkansas in A State Plan for the Conservation of Archeological 

Resources in Arkansas (Davis 1992). A working list of currently-used study units was 

compiled from this publication, and information required to define and characterize these 

study units in terms of key sites and diagnostic artifacts was gathered from October 2004 
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through May 2005 from books, published archeological reports, and archeological site 

records (see bibliography) by graduate student Crystal Masterson. 

Time periods used by archeologists include broad chronological eras (e.g., 

Paleoindian, Archaic, Woodland, and Mississippian), many of which are divided into 

more specific temporal sequences. Cultural phases represent archeological equivalents of 

living communities. These are defined in terms of a specified temporal duration, 

geographic extent, and diagnostic artifacts. Time periods and cultural phases provide 

contexts for interpreting the significance of individual sites. As information for each time 

period/cultural phase study unit was found, the data were entered into a Microsoft Access 

database. The database was divided into four separate tables or forms as follows: 1) Key 

Sites; 2) Periods; 3) Regions; and 4) Study Units.  

Eleven time periods are defined within the database. These are: Paleo-Indian, 

Archaic, Woodland, Mississippian, 16th Century, 17th Century, 18th Century, 19th 

Century, 20th Century, All Prehistoric, and All Historic. Database fields include: ID 

number, period name, period date range, and period summary. 

The Study Units database also contains information on 143 cultural phases. This 

covers most of the cultural phases currently used by archeologists working in the region. 

State Plan cultural phases that we did not incorporate within this database generally 

represent older study units for which information is available in out-of-print and hard-to-

find publications and reports. Database fields include: study unit ID, study unit name, 

period ID, region ID, date range, definition, key artifact list, artifact image, and artifact 

image alternate. 
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A total of 158 records are housed in the key sites portion of the Study Units 

database, but there are only 123 sites. To reiterate, key sites are the archeological sites 

(usually studied fairly extensively) that provided the basic information for study unit 

(time period and cultural phase) definitions. Some study units share key sites, and others 

have multiple key sites. Database fields include: site record number, site number, site 

name, description, study unit ID, site image, and site image alternate. 

The Study Units database also contains definitions for seven geographical regions 

in Arkansas. These regions are: Arkansas, Ozark Highlands, Arkansas Valley, Ouachita 

Mountains, Mississippi Alluvial Valley, West Gulf Coastal Plain, and Crowley’s Ridge. 

Most cultural phases are defined in terms of these regions or their major physiographic 

subdivisions. Database fields include: region ID, region name, and region summary. 

Following completion of the Study Units database, the next step was to locate site 

and artifact images that correspond to study units and key sites. This was accomplished 

by using the Find tool in the Access image database. A search was run for each key site 

to locate images associated with that site. Once the images were found, they were located 

on the computer’s hard drive and a copy of the image was placed in a new folder under 

the name of the site. This was done in order to ensure that the images would be easily 

found when they were integrated with the rest of the databases for Internet web 

application. 

3. Radiocarbon Database 

Information for the Radiocarbon database was gathered during the 1990s from 

both published archeological reports and archeological site records. A data form 

(radiocar.wpd) was filled out for each radiocarbon assay. The data were then entered into 
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an INFORMIX database (radiocarbon1 & 2 & 3 data screen) within the Survey’s 

AMASDA database. These tasks were completed prior to the onset of this grant. For the 

purposes of this grant, the Radiocarbon data was unloaded from AMASDA into a 

Microsoft Excel spreadsheet. Each of the entries was doubled checked for accuracy and 

additional data were added as necessary.  

A total of 520 assays have been entered into the database. Fields include: 

archeological site number, project number (if applicable), cultural affiliation, 

provenience, context and description of the sample taken for the radiometric date, date of 

the sample, and bibliographic citations for the assay.    

4. Citations Database 

The AAS is the official repository for all records pertaining to archeological sites 

and archeological projects in Arkansas. As an archeological project is completed, all 

records and reports are submitted to the AAS Registrar’s Office. These reports are 

considered the “grey literature” of archeology. In many cases only a few copies (usually 

less than ten) are produced so most of these reports are not available in libraries. The 

Survey began entering these biographic references into Oberon Citation bibliographic 

software in the late 1990s. This project allowed the records to be updated with their 

respective AMASDA project numbers and checked for accuracy. To date, we have 6802 

reports related to Arkansas and 2037 general and Southeast US archeological references.  

As part of this project, a handbook was developed to ensure consistency in data 

entry. This handbook is provided in Appendix D. 

 

 



 

9 

 

5. Internet Web Application Development 

With completion of these five databases, the next task undertaken in this project 

was to create a web application to provide access within a single, integrated framework. 

This required several steps, which were completed by graduate student John Samuelsen. 

First, data in the separate Access, Excel, and Citation databases had to be transferred to a 

single database platform where it could be viewed, changed, and updated within a web 

format. MySQL’s database was perfect for this since it has extensive, flexible, and 

programmable storage and retrieval capabilities. As an open-source application, it can be 

controlled using a variety of web-based programming languages. We chose PHP 

(Hypertext Preprocessor) as our programming application, given its ease of use and 

suitability for our purposes. 

 The following is a general outline of how the data were transferred into the 

MySQL database: 

• All of the data for the study units and radiocarbon assays were initially entered 

into Microsoft Access databases. These data were transferred to MySQL using 

Access’s export functionality and the ODBC database support provided by Access 

and MySQL. 

• The Oberon Citation database uses a proprietary format. The text output from that 

format was deciphered and a program was built to upload the bibliographic 

citations to the MySQL server from the text output. 

• The site and artifact images in their original Access databases were uploaded to 

the MySQL server using a PHP script. These images are large for a database and 

required a bit of tweaking to get that much data to reside at once in the database. 
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As all of these data were transferred they were re-formatted for MySQL. 

A modification of the citation upload program was also created to allow the 

Citations database to be updated as often as necessary from a remote computer. A similar 

program for the Radiocarbon database was created for the same purpose. 

The next step was to create a web application to provide access to the MySQL 

database via the Internet. We selected the Apache web server as our development 

platform, which, like MySQL, is an open-source application programmable with PHP. 

We created a working web interface, called “Crossroads,” for the Apache/PHP/MySQL 

configuration using a combination of HTML (Hyper-Text Markup Language) and PHP. 

An administrative login tool was also built to enable project members to update 

and modify the database via Internet connection. A data section of the website was 

created to allow logged-in users to update the content of the website, including study 

units, site images, and artifact images. 

The prototype “Crossroads” website currently permits searches of the Study 

Units, Citations, and Radiocarbon databases. The Archeological Site Images and Artifact 

Images databases are integrated within the Study Units database, as described below.  

Results 

Users logged into the system go to a welcome page that provides a brief 

description of the Crossroads application. This page also permits users to search the 

Study Units, Citations, and Radiocarbon databases. To search the Study Units database, 

users can first specify a region of the state and/or a time period. Seven state 

physiographic region selections are provided along with nine time periods ranging from 

11,650 B.C. to the present. So, for example, the user may select the Arkansas River 



 

11 

 

Valley during the prehistoric Woodland period (650 B.C. – 950 A.D.). The results of this 

search are returned in the form of a list of study units conforming to the search 

parameters. In this example, a single study unit—the Plum Bayou Culture—will be 

identified. 
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 Next, the user can retrieve more specific information by selecting one of the study 

units, one at a time. This takes the user to a new page containing the following 

information: 1) a brief definition for the selected study unit, along with defining regional 

and temporal parameters; 2) a list of diagnostic artifact types; 3) a hyperlinked list of key 

sites; 4) diagnostic artifact images, and 5) a list of bibliographic references.  

Clicking on a key site hyperlink will take the user to a Key Site page that displays 

additional information: 1) a site description, 2) site images, 3) artifact images, and 4) a 

table containing information on all radiocarbon assays for the site. 
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 There are two other options for searching the Study Units database. One option 

produces a list of all study units, from which individual units may be selected. Another 

option produces a list of all key sites, from which individual sites may be selected. 

 The Citations database can be searched directly by selecting “Citations” from the 

Crossroads web application home page. Basic searches can be initiated by typing a text 

string (for example: Plum Bayou). There is also an advanced search screen where users 

can specify authors, dates, titles, keywords, etc. The Citations database home page also 

provides a keyword list and instructions for text string searches. 
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 The Radiocarbon database can also be searched directly by first selecting it from 

the Crossroads home page. Three search fields are provided: site number, site name, and 

AMASDA number. A successful search will return 26 fields of information for each 

radiocarbon assay. 

 

Conclusions 

Testing of the Crossroads web application at the AAS Coordinating Office 

demonstrated the basic functionality of the system. The search features described above 

work smoothly and consistently, and Registrar’s Office staff has been using the 

application regularly to respond to requests for bibliographic citation and radiocarbon 

assay queries. Use of the Study Units database, however, is presently compromised by 

the lack of corresponding site and artifact images for many study units and key sites. This 

is a result of the mechanism by which research station archeologists selected images for 

scanning during this project. Generally, the station archeologists selected site and artifact 

images that correspond to their current or recent research projects. Moreover, good 

photographic images are not available for many sites, especially those that have not been 
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investigated by the AAS. These shortcomings can be rectified by a dedicated search of 

existing photographic records at the various AAS facilities across the state and, in some 

cases, by revisiting and photo-documenting existing sites and collections. The present 

content of the Crossroads web application does contain, nonetheless, images of sites and 

artifacts representative of recent and ongoing research in the state. 

Recommendations 

A few remaining tasks need to be completed before the Crossroads web 

application can be deployed for use by the AHTD and other state and federal agencies.  

 First, a small number of study units and key site descriptions remain to be 

completed; the specific information required is located in hard-to-find sources that were 

unavailable to the graduate student who very capably compiled the rest of the information 

for the Study Units database. This remaining information can be supplied by AAS 

professional staff who will also review the completed descriptions for accuracy and 

consistency. 

 Second, testing of the application by AAS staff has revealed that the usability of 

the application can be improved with the addition of a concordance table to provide 

associations and links between the Study Unit time periods and cultural phases and other 

“cultural affiliation” categories currently used in the AMASDA Site Files database. 

 Third, more photographic images should be added so that more of the study units 

in the Study Units database will have pictures of key sites and diagnostic artifacts. 

 Finally, minor changes in the interface design can be made to enhance its 

usability. 
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Appendix A 
 

AAS Digital Image Library 
SLIDE SCANNING PROTOCOL  

 
Quick Guide to Scanning 
 

1. Open needed software: Nikon Scan 3.1, Adobe Photoshop, MS Access. 
2. Remove slides from sleeves and sort by mount type. 
3. Record AAS slide number on log with its corresponding file name (this sheet 

stays with the slide book). 
4. Verify scanning information correct within the Nikon software. 
5. Scan slides. 
6. As scanning, enter basic information into MS Access tables and crop/rotate 

images in Adobe Photoshop. 
7. Enter information from recording sheets/field photo record into MS Access 

“Index” table. 
 

Getting Started 
 
Log in to the computer (see Deborah Weddle for the computer’s password).  Start the 
Nikon Scan 3.1, Adobe Photoshop, and MS Access software.   
 
Preparing the scanner 
If you are scanning single slides, the scanner remains in an upright position.  Turn the 
scanner on and wait for the status LED to return to a solid green.  Open the slide cover 
(black), and gently insert the MA-20 slide-mount adapter into the scanner.  The status 
LED will blink in acknowledgement and glow steadily if the adapter has been properly 
inserted.   
 

 
Figure 1 The MA-20 Slide Mount Adapter 

Power Button



 

 

 

If you are batch scanning, the scanner needs to lie on its side with the power button on 
the right.  Turn on the scanner and wait for the status LED to return to a solid green.  
Open the slide cover (black), and gently insert the SF-200 slide feeder into the scanner.  
The status LED on the front of the adapter will blink in acknowledgement and glow 
steadily if the adapter has been properly inserted.  When using this adapter, the scanner 
needs at least 10 cm open on each side to allow for proper air circulation around it. 

 
Figure 2 The SF-200 Slide Feeder 

Gathering slides 
Acquire slides from Lela in the Registrar’s Office.  She will be able to provide you either 
Coordinating Office slides or slides from Survey offices around the state.   
 
Within each year, sort the slides by mounting type (round, square, plastic, etc.) and 
processing type (Kodachrome, Ekatchrome, etc.).  Take note of any slides that are 
damaged, warped, strange coloration (sepia or B/W instead of RGB), or any other 
irregularity.  Remove these slides for either individual scanning or batching by 
similarities.  BATCH IN GROUPS OF NO MORE THAN 50 SLIDES. 
 

 
Figure 3 - Round and Square Cornered Mounts 

Power



 

 

 

Loading the adapter 
If scanning individual slides with the MA-20 slide-mount adapter, the slides need to be 
inserted with the emulsion side down and the short side of the slide aperture toward the 
scanner.  Stop when the slide contacts the rear of the film slot.   
 

     
         Figure 4 – Incorrect Insertion of Slide      Figure 5 – Correct Insertion of Slide 

If batch scanning, the slides need to be inserted into the feeder with the emulsion side of 
the slide facing the push plate (for the plasti-mounted slides, this will usually be the non-
flat side; for Kodachrome slides, this will be the side that says Kodachrome).  For 
Kodachrome slides, generally the word “Kodachrome” will be upside down and hidden 
by the push plate.  Do not worry if the image no longer is oriented correctly.  The entire 
batch of slides needs to be inserted in the same direction.  Do not load the feeder past the 
load mark (50 or less slides), as this may cause the feeder to jam. 
 

 
Figure 6 - Correct Batch Scanning of Slides 

 
FYI:  Acceptable mount sizes for the scanner are: 1.0-3.2 mm thick and 49-50.8 mm 
wide.  If in doubt check the SRP lab for calipers to be certain of the size.  For thicker 



 

 

 

A 

B 

C 

D 

E 

F G 

H 

I

J 

K

A.  To Scan                E.    Summary Screen   I.   Crop Tools 
B.   Eject Slide                F.    Preview Button   J.   Post Processing Tools 
C.   User Settings                            G.   Scan Button    K.  Scanner Extras 
D.   Tool Palette                H.    Layout Tools 

mounted slide, an adapter and utility software is available for the batch feeder.  
Plastimounted and Kodachrome slides may become jammed in the feeder/scanner.  Be 
sure to evaluate each slide’s condition prior to scanning.  Any slides that are warped, 
fraying, or in fair to poor condition should be scanned individually.   
 
Prepare to Scan 
 
Once the scanner is ready, return to the Nikon Scan 3.1 software.  Before scanning, the 
software needs to be made aware of how to scan the images.   
Figure 7 – The Scanning Window with the Tool Palette 

 
 

 



 

 

 

The above figure provides a look at all the useful objects within the scanning software.  
To begin, if the scanning window (B-G) is not open, open it by pressing the Nikon icon 
(A).  Select the preview button to view the first slide image.  When batch scanning, the 
slide will be pushed into the scanner and a temporary scan taken.   
 
The Defaults 
The scanner should be set with the user defaults as shown in the tool palette (H-K).  If the 
tool palette is not open, open it (D).  Should the settings not be set to the default, first 
attempt to reset the user settings found within the Settings drop down menu (C).  They 
are identified as AAS Slide Scanning Defaults.  The default values are: an output size of 
roughly 5.6 inches by 3.82 inches (with an end result of 5 x 3 once cropped) (I), a 
resolution of 300 pixels/inch (I), a file size of around 5.5 Megabytes (I), Digital ROC at 5 
(J), Digital GEM at 1 (J), Normal Mode for Multiple Sample Scanning (K), a scan bit 
depth of 8 (K), and the number of slides to be scanned should be tallied (K).  The Digital 
ICE should be turned off (J).  Most of the Survey’s slides are Kodachrome (C), but 
everything else will need to be set to Positive when selecting a medium.   
 
The Digital ICE attempts to remove any scratches or dust on the slide.  Unfortunately, 
with Kodachrome slides this process desharpens all the edges in addition to simply 
removing the dust.  ROC is a color enhancing tool attempting to replace the blanched out 
colors that often occur over time.  GEM works on the graininess of the slide 
(theoretically, this should never be a problem for our slides).  Feel free to adjust either the 
ROC or GEM to see if they produce a more or less improved image.  Be sure to select the 
Redraw button at the conclusion of your experimentation.  The Summary Screen (E) will 
no longer contain exclamation points surrounded by yellow triangles.   
 
Once you press scan, the first box will be a series of options which should all be checked 
and should remain as the default.  The final box indicates what you want to name the 
created files, where they should be stored, and what type of file you want to create.  The 
file’s prefix should be the Survey office’s prefix.  Select to carry the number to six 
places; then, double check the number already selected as being the correct one (it should 
remember what slide number you finished with the previous time and will select the next 
consecutive number to begin).  Select the directory in which to save the file, e.g. C:\Slide 
Scanning\CO Images.  Each Survey station has its own images folder.  The file type 
needs to be a TIFF.  Press OK and the scanner begins working.   

Figure 8 – Scan Saving Settings 

   



 

 

 

C:\Slide Scanning\CO Images\CO1960\CO000001.tif 
The File Naming Convention 
 
Files will be identified with a standard naming convention.  The images will live in a 
folder on the C drive under “Slide Scanning.”  Each Station will have its own folder 
identified by its abbreviation (e.g. the Coordinating Office’s folder is CO Images).  
Within each Station’s image folder will be folders by Station abbreviation and year (e.g. 
CO1960, CO1961, etc.)  The individual files will reside within these folders.  They are 
named with the Station’s abbreviation and numbered consecutively carried to six digits 
(e.g. CO000001).  The numbers do not start over for each year, but continue sequentially.  
For example, CO000174 is found in folder CO1960, while CO000175 can be found 
under folder CO1961.  By continuing the consecutive numbering, slides from different 
years can be scanned within a single batch. 
 
For the Coordinating Office, the years 1950-1959 are anomalous because they were 
scanned prior to the naming protocol’s development.  They are named by the year, “CO,” 
and sequential numbers that are restarted for each year (basically mimicking the existing 
AAS slide number).  Starting in 1960, the files follow the above outlined protocol.   
 
The file format is a TIFF to avoid loss of information by compression.  The file size is 
not as great an issue as quality. 
 
Should you accidentally assign the same number to two different images, the Nikon 
software will automatically rename the most recently scanned slide by adding a prefix to 
the file name. 
 
Scanning 
 
Depending on the age of the slides/type of slides, the scanner may require more or less 
baby-sitting.  Often, simply restricting the movement of additional slides will allow for a 
more continuous scanning process.  To restrict their movement, isolate the first slide (or 
the slide to be scanned) from the rest of the group by holding the second in line with a 
fingernail/paperclip/pencil point.  By restricting its movement, only the first slide will be 
grabbed by the scanner. 
 
What to do if the scanner jams 
Periodically verify that the scanner has not jammed and to check its progress.  To unjam 
the scanner, first remove any slides from the feeder and the ejection magazine.  Check for 
slides that are visible and can be gently removed.  If slides are caught inside the scanner, 
the attachment utility will need to be used.  The utility is a shortcut on the Desktop – 
FDUtility.exe. Close the Nikon Scan 3.1 software and open the utility.  Select the reverse 
button until all slides are removed from the scanner.    
 



 

 

 

 
Figure 9 - FDUtility for Removing Jammed Slides 

 
Select OK.  Reopen the Nikon Scan software.  Reinsert the slides to be scanned, 
including those caught in the scanner.  Review the scanned slides in Photoshop to 
confirm which slides where scanned and which ones were not.  Delete any files with 
errors (e.g. only half the image was recorded due to another slide covering it).  Take note 
of the final file number for use when restarting the Nikon Scan software.  Restart the 
scanning process, inserting the “new” start number in the File Saving Options box. 
 
When completed 
The adapters need to be removed at the conclusion of each scanning session.  The slide 
cover needs to be returned to its closed position.  Return the adapters to their protective 
box; stand the scanner back up-right.   
 
To Remember 
 
If the green LCD on the front of the scanner is blinking, do not move the scanner or 
attempt to remove any adapters attached to the scanner.   
 
WHEN HANDLING THE SLIDE FEEDER, CARE MUST BE TAKEN AT ALL 
TIMES TO BE GENTLE WITH ITS INSERTION INTO THE SCANNER, THE 
OPENING OF THE MAGAZINE COVER, AND THE PUSH PLATE!!! 
 
When all else fails, check the softcover manuals for the scanner and feeder or the 
scanner’s CD-Rom manual. 
 



 

 

 

The Data Entry 
 
The data entry into MS Access is comprised of two steps: 1) entering information about 
the AAS image number and the newly assigned file name, including what steps were 
taken in scanning; and 2) entering image specific information for cataloging purposes.  
The database is located at C:\Slide Scanning\Scanning.mdb.  Within it are all the tables 
and forms discussed below. 
 
Keeping Track of the AAS Slide Number and the File Name 
  
To help keep track of what AAS slide number equals what digital image several protocols 
are in place:   
 
As you remove the slides from the notebooks, write down their AAS slide numbers and 
equivalent folder and file name on the Scanning Log (see examples from CO Slides book 
1960 through 1961).  This log will live stay with the notebook.  Additional copies of the 
logs can be made from the MS Excel spreadsheet C:\Slide Scanning\Slide_Log.xls 
 
As the slides are scanned, two tables in the MS Access database also keep track of the 
AAS slide number and the individual file names.   
 

1. Image_file_name_(Station abbreviation):  This table is a simple, correlative 
electronic record of the AAS slide number and the newly assigned electronic file 
name as a hyperlink field (be sure to include the folder information in the record 
information, e.g.1960CO\CO000001).  The AAS slide number year information 
should be expanded to a four digit year, rather than the two digits often notated on 
the slide. 

2. Scanning_Information_(Station abbreviation):  This table provides the date 
scanned (auto-generated), the file name, and what scanning techniques (ICE, 
GEM, ROC, cropping, rotating, etc.) were applied.  It also enters in the scanning 
personnel’s last name (can be auto-generated) to assist in keeping track of who is 
doing what.   

 
To avoid later confusion, it is best if this information is entered as the slides are scanning.  
For ease in entering the information, the two tables have associated forms of the same 
names.   
 

  
Figure 10 – Image_File_Name and Scanning_Information Forms 

 



 

 

 

The Index 
 
The most important step of this entire process is entering the information regarding the 
specific image.  This information is contained in one MS Access table – Index.  Like the 
naming and scanning techniques tables, it also has a form of the same name to make it 
easier to fill out the information.   
 

 
 
Some of the information entered is duplicative of existing information in AMASDA and 
for individual slides, especially when there are several images of the same thing.   
 
Information entered needs to be in ALL CAPS for consistency and appearance.  All the 
fields with drop down boxes will fill in automatically if a specific value is entered.  Due 
to the nature of Access, abbreviations are not necessary.  
 
An explanation of each field is found below.  For examples of the field values, see attached 
slide file index dictionary of searchable criteria developed by the McGimseys. 
 

 Slide Name:  This field refers to the AAS slide number.  The two-digit year found 
on the slide should be expanded to the four-digit year. 

 Year Taken:  This field refers to the specific year associated with the slide, i.e. the 
year indicated by the slide number.  

 Site Number:  If the image is associated with a specific site, it should be noted here. 



 

 

 

 Site Name:  If the image is associated with a specifically named site, without a number 
is when this field is the most significant.  If a site’s name is known, enter it here. 

 Site Area:  If the location of the image is completely unknown, but the image 
came from a specific Survey Station, take note of the Station.  The Stations are 
identified by their abbreviations and location.   

 County: If the location of the image is known, the associated county should be 
noted here.  A table exists within the database providing the county abbreviations 
and associated AMASDA numbers, if only an abbreviation is provided.   

 State:  What seems like an unusual field for a state image library is included 
because some images are of sites and excavations performed in neighboring 
states. 

 Project Name:  If the work was performed as part of a larger project (academic 
or contract) it should be noted.  Contract numbers are also appropriate. 

 Sponsor:  This field is for projects sponsored by an organization, like a field 
school, or the agency responsible for the work, like the U.S. Army Corps of 
Engineers. 

 Contractor:  When the project is performed due to federal or state regulations, 
the specific organization/contractor doing the work needs to be noted, like SRP.   

 Conference:  If the slide was taken at a conference or meeting, the event name 
needs to be noted. 

 People:  When people are contained within the image, who are they? 
 Name(s) of People:  When known, the name(s) of the people needs to be noted. 
 Landscape:  When the image is of not a specific location but a general view of the 

site as a whole 
 Excavation:  When the image is of specific excavations and what type 
 Burial(s):  If the image contains burial(s) 
 Artifacts (formal):  If the image is of formal artifact shots and what type of 

artifacts.  When the image contains a multiple of categories, be sure to take note 
of each. 

 Illustrations:  Images of illustrations, maps, drawings used in slide shows 
 Structure(s):  What type of architectural features are in the image? 
 Rockart:  To complement the existing rockart database, images of pictographs, 

petroglyphs, etc., should be noted. 
 Comments:  Any information contained on the field photo record or in the image 

recorders notes not captured in the above fields. 
 Image Recorder:  Who recorded the information on the image 
 Date Recorded:  When was the information recorded (recorder and date are 

specific to the McGimsey’s records) 
 DB Recorder: Who entered the information into the database? 
 Date Entered:  When was the information entered into the database? 

 
 
That’s it.  If you survived the above pages, you should have no difficulties that you are 
not able to overcome.   
 
Good Luck and Enjoy! 



 

 

 

AAS Digital Image Library 
Scanning Log 

 
Photo Book: _____________ 

 

Date AAS # Folder/File Name Initials 
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Appendix C 
 
 RADIOCARBON DATABASE 
 
 
Site Number:_________________________    Site Name: ____________________________ 
 
Location (if not associated with archeological site): ___________________________________ 
 
____________________________________________________________________________ 
 
Provenience: _________________________________________________________________ 
 
Association/Context: __________________________________________________________ 
 
Cultural Affiliation: ___________________________________________________________ 
 
Radiocarbon Assay: _____________________   Uncorrected date: _____________________ 
 
Corrected Date(s): _____________________     Calibration Program: __________________ 
 
Radiocarbon Lab Number: _______________     14C Half-life Value Used: ____________years 
 
Type of Material Dated: ________________________________________________________ 
 
Dating Technique:    Standard_______     Extended_______    AMS _______ 
 
Special Analyses:   C13/CC12 _____________     O18/)16____________________________ 
 
Submitted by: ________________________        Institution: _______________________ 
 
Date Submitted: ______________________        Reference: __________________________ 
 
Comments: 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 
radiocarbon1 data screen 

 
 
 

 
radiocarbon2 data screen 

 



 

 

 

 
radiocarbon3 data screen 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



 

 

 

Appendix D 
 

CITATION GUIDELINES 
 
 

The following pages are used as a guide on how to enter information in Citation in a 
standardized way.  There are three sections to the guide.  Basics explains how to use 
Citation.  Only the most commonly used functions are explained.  Specifics discusses 
special instructions to follow while working in Citation for the Registrar Office of the 
Arkansas Archeological Survey.  Finally, Data Fields gives a list of the fields, from a 
range of record form styles, thus far used by the Registrar Office to enter information in 
Citation. 
 
Basics 
 
1. Double click on Citation to bring the program up. 
2. Go to File → Open Datafile, and then find the correct file in which the new record 

will be entered or a current record will be edited.  Double click on the file name to 
open.  

3. If entering a new record:  
Go to Edit → Add Record (the new record will be added at the end of the file) → 
Select Form (highlight the appropriate record form) → OK.  If you would rather place 
the record in its appropriate filing spot, go to the record which will immediately 
follow the one to be entered, and then go to Edit → Insert Record (the new record 
will be inserted immediately preceding the record you were on) → Select Form 
(highlight the appropriate record form) → OK.  Enter record information in 
appropriate fields.  

4. If editing an existing record:  
Go to Search → Search for Record (F5 key) or Find Text (F2 key).  Enter appropriate 
search words → OK.  Once record is located, make necessary changes.  

5. If you do not believe the selected form is the most appropriate for the record in hand, 
you may change the type of form by: 
Go to Edit → Change Form → Select Form (highlight the appropriate record form) 
→ OK.  Make any additions/changes in the fields. 

6. If any part of the information being entered needs to be italicized, underlined, or put 
in bold, 
Highlight the needed text, and then go to Edit → Attributes → Italics/Underline/Bold. 

7. Once all applicable information have been entered in the fields, check the spelling 
by:   
Go to Tools → Spell Check → Record. 

8. If the records have not been entered in alphabetical order, you may sort the datafile. 
Go to Tools → Sort.  Sort Datafile box appears:  Sort Order → Ascending; Sort Type 
→ Bibliographic (Author, Year, Title); OK.  Sort Finished box appears: Save As → 
Save in appropriate folder → File name should end with “.dat”. 

9. If you need to select a subset of the datafile, 



 

 

 

Go to Tools → Select.  In the Select box that appears, you may choose all tagged files 
or choose by querying in certain fields (such as selecting all the records by a specific 
author).  Select Finished box appears: Save As → Save in appropriate folder → File 
name should end with “.dat”. 

10. If you need to tag a record(s) in order to select it later, 
Go to Edit → Tag/Untag (Ctrl+T).  To untag a record you would do the same process.  
If you need to untag all records, go to Edit → Untag All.   

11. If you need a bibliography of selected records: 
Tag and Select the records needed (see above for instructions).  Open the newly 
created datafile.  Open Microsoft Word.  In Citation, go to Generate → Bibliography 
from Datafile.  Bibliography box appears.  Publishing Style: standard → choose style 
from drop-down list → OK.  Bibliography appears in Word.  

12. To save: 
Go to File → Save (Shift+F3) or Save As (F3 key) if this is a new datafile. 

 
 
Specifics 
 
I. Reports/Contract Reports 

i. All reports with an AMASDA number will be entered into a Project 
Report form. 

ii. All reports without an AMASDA number will be entered into a 
Technical Report form. 

iii. If a project is conducted in the state of Arkansas, it should have an 
AMASDA number and thus entered into a Project Report form.  If no such 
number is written on the report, search in ergaster or check with the 
Registrar to find the number.  

iv. Enter the AMASDA number on the upper right hand corner of the 
report cover if none has been entered and if one is available.  

v. For reports with an AMASDA number, you may need to search 
through ergaster or check with the Registrar to find any information not 
available on the report. 

vi. For records published in journals or other forms of records AND have 
an AMASDA number, they too will be entered into a Project Report form.  
For such cases, at the end of the abstract, enter in parenthesis its source.  
Specify journal name, volume and issue numbers, editor, publisher name, 
place of publication, page numbers, conference presented at, and/or any 
other pertinent information.  It will look something like follows: (In 
\iArkansas Archeology 1962\i; Edited by Charles R. McGimsey III; 
Published in 1963 by The Arkansas Archeological Society; Pages 15-65.). 

vii. See Appendix A for detailed instructions on how to enter information 
in a Project Report form.  

 
II. Site Numbers 

i. If site numbers are given in the record, for any state, enter them in the 
abstract field.  



 

 

 

ii. For site numbers in the state of Arkansas, make sure that the leading 
zeroes are entered (all Arkansas state site numbers must have four 
numerical digits).  For example, 3WA25 would be entered as 3WA0025 
(FYI: 3=Arkansas, WA=Washington county or other county code, 
0025=25th site given a number in the county). 

iii. If more than 15 sites are listed in a record, there is no need to enter 
them all.  In such cases, you may just state the number of sites in a county 
or only list the newly recorded sites.  It is up to you, the recorder, to 
determine how to best approach such records.  Use your own judgment for 
each specific case! 

 
III. Length/Number of Pages/Page Numbers 

i. Always enter the length of a record. 
ii. If a form does not have a field that prompts you to enter the length or 

page numbers of a record, then enter this information in the Descriptor 
field.  However, if the Descriptor field is being used for other purposes, 
then enter the record length in another seemingly appropriate field (such 
as the Available/on file field) or else at the end of the abstract in 
parenthesis.  

 
IV. Abstract 

i. Always enter an abstract in the Abstract field, even if one is not 
provided in the record. 

 
V. Extended Forms 

i. Extended record forms, such as Article in a Journal [extended form], 
are ONLY chosen when the extra fields are needed. 

 
VI. File Cabinet 

i. All records that will be filed in the file cabinets of the Registrar Office 
must have the words FILE CABINET entered on the record form. 

ii. On most record form styles, FILE CABINET will be entered in the 
Reference field.  If there is no such field, then enter it in the Comment 
field, even if other information is being entered there.   

iii. An exception to the above is found on the Notecard record form. In 
this case, enter FILE CABINET in the On File field. 

 
VII. Miscellaneous 

i. When it may be ambiguous under what a record is filed, specify it in 
the Comment field (example: FILE CABINET under “Hardware/Nails” or 
Filed under “AR Archeological Survey-5-Year Plan”). If there is no 
Comment field, then enter this information in the Abstract field, following 
and below the abstract. 

ii. Write out dates (example: May 29; NOT 5/29) 
iii. Unless absolutely needed, use the Notecard record form instead of the 

Notes record form. 



 

 

 

iv. If information is missing on your record, such as a book’s publisher, 
you can look it up on the UofA library catalog.  Such information may 
also be looked up on the World Wide Web.  However, do not spend too 
much time on such endeavors, and make it a quick search. 

v. Not all of the fields on a record form have to be filled in.  Enter 
relevant information in the appropriate fields only. 

vi. Always enter an abstract and keywords. 
vii. Always run the spell check. 
viii. Save your work on both the hard drive and on a disk. 

 
 
Data Fields 
 
Abstract:  An abstract always needs to be entered, even if one is not provided in the 
record.  Keep in mind that the abstract should answer the basic questions of who, what, 
when, where, how, and why in a simple and concise manner.   

If an abstract is included in the record, you can type word for word or just part of 
it.  If you do use the abstract provided in the record, make sure you put at the end of it 
“[Abstract included with x]”.   

If the record does not have an abstract, you may use sentences from the record to 
make up an abstract.  At the end of this type of abstract put “[Abstract extracted from 
x.]”.  

If a spelling mistake was made in the abstract or extracted parts of the record as 
originally written, add “(sic)” immediately following the misspelled word.   

Key points to include in an abstract: type of archeological work or study; location 
of work; who conducted the work; any new sites recorded and number of; any previously 
recorded sites visited and number of; type of sites (prehistoric, historic, or 
multicomponent); site numbers; study results; and recommendations.  All Arkansas site 
numbers must have a four-digit number, which means that their leading zeroes need to be 
included.  For instance, if the site is 3MN60 it should be written as 3MN0060. 
 
Access Phrase:  This is automatically entered for you, and is a quick reference of author 
and year.  However, make sure the spelling is correct and reads last name of authors and 
year of report.  
 example: Riggs 1997 
 example: Rose et al. 1992 
 
Article Title:  This is the title of the record.  Enter the title exactly like it is on the record.  
If any part of the title is written incorrectly on the record, enter “[sic]” following the 
misspelled word.  
 example: Cultural Resource Surveys in the Cossatot and Leader Mountain Areas 
of the Quachita (sic) National Forest 
 
Author, Author of piece:  Enter the name/s of the author/s.  Spell the author’s name as 
written exactly on the record.  List all authors.  For multiple authors, place a semicolon 
after each.  All authors’ names should follow this style:   



 

 

 

last name, first name middle initial, Jr. or III. (if applicable) 
example: Kelly, A. R.; Larson, Lewis H., Jr. 

 
Available/on file:  This field is sometimes used for entering the length or page numbers 
of a record, if no other such fields exist on the form.  In such cases, you may need to 
count the number of pages if they are not typed in.  If appendices, figures, and/or tables 
are in addition add “plus appendices” or “plus figures and tables”.  If the latter were 
included in the length of the record, add “including appendices”. 
 example: 11 pages plus appendix 
 example: 39 pages plus figures 
 example: 109 pages including appendices 
 
Bk Editor:  Enter the name/s of the book’s editor/s.  Spell the editor’s name as written 
exactly on the record.  List all editors.  For multiple editors, place a semicolon after each.  
All editors’ names should follow this style:   

last name, first name middle initial, Jr. or III. (if applicable) 
example: Heizer, Robert F.; Cook, Sherburne F. 
 

Bk (Collection) Ttl:  Enter the title of the book or collection that the record appears in.  
Enter the title exactly like it is on the record. 
 
Book Title:  Enter the title of the book.  Enter the title exactly like it is on the record. 
 
Cast Description:  Enter the format of the record. 
 example: CD-ROM 
 example: 3 ½ Floppy 
 example: Microfilm (3 rolls of 8mm film) 
 
Collection Title:  Enter the title of the collection that the record appears in.  Enter the 
title exactly like it is on the record. 
 
Congress no.:  Enter the congress number. 
 
Congressional body:  This is the author of the record, and would be the name of an 
entity instead of a person’s. 
 example: House of Representatives 
 
DA/DAI: 
 
DAI Year: 
 
Day/Month/Qtr:  Enter the date on which the record was published, in which monthly 
issue it appears, or on what day it was presented or written on.  Spell out the month 
names. 
 example: December 
 example: Sunday, May 6 



 

 

 

 example: April 6-7 
 example: Winter 
 
Dept/Coll:  Enter the department name to which the record was submitted to, or in which 
the author was a member of. 
 example: Department of Anthropology 
 
Descriptor:  This field has different purposes on different record forms.  Mostly though, 
it is used for entering the length or page numbers of a record, if no other such fields exist 
on the form.  In such cases, you may need to count the number of pages if they are not 
typed in.  If appendices, figures, and/or tables are in addition add “plus appendices” or 
“plus figures and tables”.  If the latter were included in the length of the record, add 
“including appendices”. 
 example: 11 pages plus appendix 
 example: 39 pages plus figures 
 example: 109 pages including appendices 
On a Dissertation record form, this field is used to specify if the record is a dissertation or 
a thesis, and the degree sought. 
 example: Dissertation, Doctor of Philosophy 
 example: Thesis, Master of Science 

example: Internship Portfolio, Master of Arts 
 
Director (Author):  Enter the name/s of the director/s or author of the source.  Spell the 
author’s name as written exactly on the record.  List all authors.  For multiple authors, 
place a semicolon after each.  All authors’ names should follow this style:   

last name, first name middle initial, Jr. or III. (if applicable) 
example: Cooper, Judy 

 
Document no.:  Enter the number of the record.   
 
Doc Section:  Enter the section in which the record is found in. 
 
Document type:  Enter the type or format of the record. 
 
Edition:  Enter the edition, volume, and/or issue number of the source in which the 
record is found in.  

example: Vol. 8, No.10 
example: 5th 

 
Editor:  Enter the name/s of the record’s editor/s.  Spell the editor’s name as written 
exactly on the record.  List all editors.  For multiple editors, place a semicolon after each.  
All editors’ names should follow this style:   

last name, first name middle initial, Jr. or III. (if applicable) 
example: Sassaman, Kenneth E.; Anderson, David G. 
 

Expl. note:  Enter any additional comments or explanatory notes. 



 

 

 

 
Issue:  Enter the issue number of the journal or series in which the record is found in.  
Also, if there are other numbers beyond volume and issue numbers, enter such 
information here. 
 example: 4 

example: 50, Pt. I 
 
Journal:  Enter the title of the journal that the record appears in.  Enter the title exactly 
like it is on the record. 
 
Keywords:  List the keywords in order of importance.  Typically begin with the country, 
area, or state under discussion, then the county or counties where the project took place, 
type of archeological survey, then if sites are prehistoric or historic, specific 
time/occupation periods, anything done with the artifacts like an inventory or analysis, 
etc.  Use a semicolon (;) between each keyword.  A list of the keywords thus far used 
may be seen by clicking on the arrow on the right-hand side of the keyword field.  Just a 
note, some projects will have only a few keywords, while more detailed ones will have 
more. 
 example: Arkansas; Craighead County; archeological identification survey; 
prehistoric; historic; Late Archaic; Mississippian; Anglo-American 
 example: Southeast U.S.; Mississippian; symbolism 
 example: site preservation; interdisciplinary research; cave deposits; rock shelters 
 
Length/Comment:  Enter the length of the record.  Also enter the location of the record 
in this field, following the length. 
 example: 46 minutes 
 example: In file drawer. 
 example: 3 tapes 
 
Newspaper:  Enter the name of the newspaper that the record appears in.  Enter the 
newspaper name exactly like it is on the record. 
 
Pages:  Enter the page numbers or length of the record.  You will need to count the 
number of pages if they are not typed in.  If appendices, figures, and/or tables are in 
addition add “plus appendices” or “plus figures and tables”.  If the latter were included in 
the length of the report, add “including appendices”.   

example: 123-139 
example: 163 
example: 110 plus tables and plates 
example: 91 including appendices  

 
Parallel cite:JR:  If the record was published in a journal, enter the journal name here.  
Enter the title exactly like it is on the record.  
 
Parallel cite:PG:  If the record was published in a journal or series, enter the page 
numbers here. 



 

 

 

example: 123-139 
 
Parallel cite:VO:  If the record was published in a journal or series, enter the volume 
number of that journal here.  Also enter an issue number or other if the form does not 
have a separate field for such information. 
 example: 21 

example: Vol. 105, No.1 
 
Periodical:  Enter the title of the periodical that the record appears in.  Enter the title 
exactly like it is on the record. 
 
Place:  Enter the place (city and state) where the publisher or person who wrote the 
record resides.  Abbreviate the state. 
 example: Memphis, TN 
 
Place written:  Enter the place (city and state) where the person who wrote the record 
resides.  Abbreviate the state. 
 
Publisher:  Enter the name of the company who published the record. 
 
Reference:  Thus far, this field has only two functions.  1) When the record is filed in the 
file cabinets of the Registrar Office, enter the words FILE CABINET in this field.  2) If 
the record is entered in a Film record form, and it has an AMASDA number, enter that 
number in this field. 
 
Role/Publ Status: 
 
Section (IS):  Enter the section of the newspaper in which the record is found in. 
 example: B  
 example: C: World News 
 example: Lifestyle 
 
Series editor:  Enter the name/s of the series’ editor/s.  Spell the editor’s name as written 
exactly on the record.  List all editors.  For multiple editors, place a semicolon after each.  
All editors’ names should follow this style:   

last name, first name middle initial, Jr. or III. (if applicable) 
example: Sassaman, Kenneth E.; Anderson, David G. 

 
Series Title:  Enter the title of the publication series.  Enter the title exactly like it is on 
the record. 
 
Session:  Enter the type of legislative session that resulted in the record. 
 
Short Work Title:  This is the title of the record.  Enter the title exactly like it is on the 
record.  If any part of the title is written incorrectly on the record, enter “[sic]” following 
the misspelled word.  



 

 

 

 example: Cultural Resource Surveys in the Cossatot and Leader Mountain Areas 
of the Quachita (sic) National Forest 
 
State:  Enter the name of the state in which the record was produced.  Spell out the state; 
do not use its abbreviation.  example: Arkansas 
 
State leg. body:  Enter the name of the state entity responsible for the record. 
 example: General Assembly of the State of Arkansas 
 
Status:  Enter the status of the legislative record in question.  For example, has it been 
passed or denied. 
 
Studio (Publisher):  Enter the name of the company who published the record. 
 
Subsequent Cite Ttl:  This is any secondary title that may be given to a record.  For 
example, in Attachment 1, “A vast array of human remains, vertebrate and invertebrate 
fossils, and artifacts are preserved.” would be entered in this field.  Enter the subsequent 
cite title exactly like it is on the record.  If any part of it is written incorrectly on the 
record, enter “[sic]” following the misspelled word.  This field is also used to enter 
chapter numbers -- example: Chapter 8  
 
Title:  This is the title of the record.  Enter the title exactly like it is on the record.  If any 
part of the title is written incorrectly on the record, enter “[sic]” following the misspelled 
word.  
 
Translator:  Enter the name/s of the record’s translator/s.  Spell the translator’s name as 
written exactly on the record.  List all translators.  For multiple translators, place a 
semicolon after each.  All translators’ names should follow this style:   

last name, first name middle initial, Jr. or III. (if applicable) 
example: O'Donnell, Walter J. 

 
University:  Enter the name of the university to which the record was submitted to, or in 
which the author was a member of. 
 example: Harvard University 
 example: University of Arkansas, Fayetteville 
 
Volume No.: Enter the volume number of the journal or series in which the record is 
found in.  Also enter an issue number or other if the form does not have a separate field 
for such information. 
 example: 21 

example: Vol. 105, No.1 
  
Year/ Year completed:  Enter the year in which the record was published or submitted.  
If the year is unknown, enter “n.d.”.  If the year is questionable, enter a question mark in 
parenthesis following the year -- example: 1966 (?)   If the exact year is unknown but can 
be placed in a specific decade, write it as such -- example: 1960s  



 

 

 

APPENDIX A: 
 

PROJECT REPORT FORM 
 
 
 
 

The Project Report form was created by the Registrar Office of the 
Arkansas Archeological Survey for inclusion in Citation.  Such a form, 
not originally available in Citation, is needed for the Registrar Office’s 
vast number of archeological project reports.  This Project Report form 
reflects the unique types of information gathered from such records and 
that are of importance to the Registrar Office.  The following pages are to 
be consulted when entering information into a Project Report form.  They 
outline what type of information and how they should be entered in each 
field.   
 
The Project Report form is saved under FORMS.DEF of the working 
Citation program.  For those installing Citation onto their computers, 
follow these simple steps: 

i. Retrieve and install the Citation CD. 
ii. Copy FORMS.DEF from the Citation program folder, of one 

that currently has the Project Report form, onto a disc. 
iii. Take this disc to your computer and move or copy & paste 

FORMS.DEF into your Citation program folder. 
iv. You will be asked if you want to replace the current 

FORMS.DEF.  Say yes. 
v. You are now ready to go!  “citation.exe” in that same folder 

will bring up Citation for you to work in. 
 
 
 
 
 
Note: Please update and replace this and any of the following pages when 
needed. 
 
 
 
 

 
 
 
 
 
 

 
 



 

 

 

APPENDIX A: 
 

PROJECT REPORT FORM 
 

 
Author:  Spell the author’s name as written exactly on the report.  List all authors.  For 
multiple authors, place a semicolon after each.  All authors’ names should follow this 
style:   

last name, first name middle initial, Jr. or III. (if applicable) 
example: Kelly, A. R.; Larson, Lewis H., Jr. 

  
Year:  Enter the year in which the report was published.  If the year is unknown, enter 
“n.d.”.  If the year is questionable, enter a question mark in parenthesis following the year 
-- example: 1966 (?) .  If the exact year is unknown but can be placed in a specific 
decade, write it as such -- example: 1960s .  
  
Report Title:  Spell the title exactly as it is written on the report.  If a spelling mistake 
was made in the title as originally written, add “(sic)” immediately following the 
misspelled word.  
 example: Cultural Resource Surveys in the Cossatot and Leader Mountain Areas 
of the Quachita (sic) National Forest 
  
Descriptor:  This field is for a report number, a volume number, or a secondary title. 

For AAS projects, the number should be “AAS Sponsored Research Program 
Project, then number”. 

 example: AAS Sponsored Research Program Project No. 899 
For forest service reports, they have Cultural Resource Inventory Report Series, 

then the number.  This should be entered as “F.S. Project, then the number”. 
 example: FS Project Number 08-09-07-422 
For other contractors, it should be whatever they have entered as a project or 

report number. 
 example: AHTD Job# R10062 
 example: PCI Project #24011.000 
 example: SPEARS Project 127 
 example: MCRA Report No. 90-8 
 example: Historic Preservation Associates Report 84-5 
 

Place:  Enter the place (city and state) where the company or person who wrote the 
report resides.  Abbreviate the state. 
 example: Memphis, TN 

 
Publisher:  Enter the name of the company who published the report. 

 
Length/Comment:  Enter the page length of the report.  You will need to count the 
number of pages if they are not typed in.  If appendices, figures, and/or tables are in 



 

 

 

addition add “plus appendices” or “plus figures and tables”.  If the latter were included in 
the length of the report, add “including appendices”.  If the report is located in the 
Registrar’s file cabinet, add “FILE CABINET” following the report length. 
 example: 11 pages plus appendix 
 example: 39 pages plus figures 
 example: 109 pages including appendices 
 example: 5 pages. FILE CABINET 

 
Keywords:  List the keywords in order of importance.  Typically begin with 
“Arkansas”, then the county or counties where the project took place, type of 
archeological survey, then if sites are prehistoric or historic, specific time/occupation 
periods, anything done with the artifacts like an inventory or analysis, etc.  Use a 
semicolon (;) between each keyword.  A list of the keywords thus far used may be seen 
by clicking on the arrow on the right-hand side of the keyword field.  Just a note, some 
projects will have only a few keywords, while more detailed ones will have more. 
 example: Arkansas; Craighead County; archeological identification survey; 
prehistoric; historic; Late Archaic; Mississippian; Anglo-American 
  
Access Phase:  This is automatically entered for you, and is a quick reference of author 
and year.  However, make sure the spelling is correct and reads last name of authors and 
year of report.  
 example: Riggs 1997 
 example: Rose et al. 1992  
  
Abstract:  An abstract always needs to be entered, even if one is not provided in the 
report.  Keep in mind that the abstract should answer the basic questions of who, what, 
when, where, how, and why in a simple and concise manner.   

If an abstract is included in the report, you can type word for word or just part of 
it.  If you do use the abstract provided in the report, make sure you put at the end of it 
“[Abstract included with report]”.   

If the report does not have an abstract, you may use sentences from the report to 
make up an abstract.  At the end of this type of abstract put “[Abstract extracted from 
report.]”.  

If a spelling mistake was made in the abstract or extracted parts of the report as 
originally written, add “(sic)” immediately following the misspelled word.   

Key points to include in an abstract: type of archeological work; location of 
archeological work; who conducted the work; any new sites recorded and number of; any 
previously recorded sites visited and number of; type of sites (prehistoric, historic, or 
multicomponent); site numbers; and recommendations.  All site numbers must have a 
four-digit number, which means that their leading zeroes need to be included.  For 
instance, if the site is 3MN60 it should be written as 3MN0060.   
  
Agency/ Project #:  This field is for whom the project was done for or submitted to.  
Do not enter that agency’s place of business or residence, i.e. it’s location.  Certain 
agencies, such as the National Park Service, might have districts that need to be specified.  



 

 

 

Enter a project number if one is provided after the agency name.  Some notes to 
remember:   

o “COE” is for the Corps of Engineers.  Specify district.  The Corps reports 
also have a contract number.  Example: COE-Little Rock/DACW03-78-
M-0835 

o “SCS” is for the Soil Conservation Services. 
o “AHTD” is for the Arkansas Highway and Transportation Department.  
o FS is for the Forest Service.  Specify forest.  Example: FS-Ouachita 

National Forest 
o NPS is for the National Park Service.  Specify district/region.  Example: 

NPS-Southeast Region/14-10-0131-1664 
o AAS is for the Arkansas Archeological Survey 

  
Site #:  This field is reserved for those sites recommended in the report for inclusion (i.e. 
eligible) in the National Register of Historic Places.  Remember, all site numbers must 
have a four-digit number, which means that their leading zeroes need to be included.  For 
instance, if the site is 3MN60 it should be written as 3MN0060.  If more than one site is 
listed, separate them with a semicolon (;). 
 example: 3CW0248; 3CW0291; 3CW0294 
  
AMASDA #:  Enter the AMASDA number of the report here. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 
RECORD FORMS: 

 
From Articles to Unpublished Papers 

 
 
 
 

Following is a checklist with a corresponding selection of record 
forms, representing each type of form thus far used by the Registrar 
Office of the Arkansas Archeological Survey.  The record forms are to 
be consulted and used as examples on how to enter information on 
different types of forms, from Articles to Unpublished Papers.  They 
are filed alphabetically by record form type.  In certain cases, more 
than one example may be given for a specific type of record form, 
showcasing various entry possibilities.   
 

 
 

 
 
Note: Please update and replace this and any of the following pages when 
needed.  Also check off from the list any new type of record form added in the 
following pages. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

SCREEN CAPTURE: 
 

Jasc Paint Shop Pro 
 
 
 
 

The preceding printed record forms were made through the help of 
Jasc Paint Shop Pro.  The following pages explain how this can be 
done.  Briefly stated, the Screen Capture option in Paint Shop Pro 
allows one to seize an area, window, or screen, from which it can then 
be printed easily.   
 
Simply, you will need to follow these steps: 

1. Open Jasc Paint Shop Pro. 
2. Open Citation. 
3. Open the desired database in Citation and go to the record that 

you want printed. 
4. In Paint Shop Pro, after you have set the Screen Capture 

preferences (see next page), go to Start Capture (Shift+C; 
camera icon on toolbar; see following pages). 

5. With Citation up and at the desired record, capture the window 
(by right-clicking or other specified means; see following 
pages). 

6. The captured window will appear in Paint Shop Pro.  
7. Go to Page Setup under File. 

i. Choose Landscape for your Orientation. 
ii. Type 126 in the scale box. 

iii. Click OK. 
8. Go to File → Print. 

 
 
 
 
 
Note: Please update and replace this and any of the following pages when 
needed. 
 
 
 
 
 
 
 
 
 

Last Updated: May 20, 2004 



 

 

 

Appendix E 
 
Bibliography of selected cultural phases/study units 

 
East Phase 

 
Early, Ann M. 
1982  Caddoan Settlement Systems in the Ouachita River Basin. In Arkansas Archeology in 
Review, edited by Neal L. Trubowitz and Marvin D. Jeter, pp. 198-232. Arkansas Archeological 
Survey Research Series 15. Fayetteville, Arkansas. 
 
Early, Ann M. ed., 
1993  Caddoan Saltmakers in the Ouachita Valley. Arkansas Archeological Survey Research 
Series 43. Fayetteville, Arkansas. 
 
Hoffman, Michael P. 
1967  Ceramic Pipe Chronology Along the Red River Drainage in Southwestern Arkansas. 
Arkansas Archeologist 8:4-14. Fayetteville, Arkansas. 
 
Newell, H. Perry; Krieger, Alex D. 
1949  The George C. Davis Site, Cherokee County, Texas. Society for American Archaeology 
Memoirs 5. Menasha, Wisconsin. Soon available as a reprint. 
 
Suhm, Dee Ann; Krieger, Alex D.; Jelks, Edward B. 
1954  An Introductory Handbook of Texas Archeology. Texas Archeological Society Bulletin 24. 
Austin, Texas. 
 
Suhm, Dee Ann; Jelks, Edward B. 
1962  Handbook of Texas Archeology: Type Descriptions. The Texas Archeological Society and 
the Texas Memorial Museum. Austin, Texas. 
 
Weber, J. Cynthia 
1972  Ceramics of the East Mounds (3CL21). Fayetteville, Arkansas. Manuscript on file, AAS. 
 

Mid-Ouachita Phase 
 
Early, Ann M. 
1988  Standridge and Caddoan Culture in the Ouachita River Basin. In Standridge: Caddoan 
Settlement in a Mountain Environment, by Ann M. Early, pp. 157-166. AAS Research Series 29. 
Fayetteville, Arkansas. 
 
Early, Ann M. 
1993  Cultural Context; Hardman and Caddoan Saltmaking. In Caddoan Saltmakers in the 
Ouachita Valley, Edited by Ann M. Early, pp 1-14, 223-234. AAS Research Series 43. 
Fayetteville, Arkansas. 
 
Hodges, T. L.; Hodges, Mrs. 
1963  Suggestion for Identification of Certain Mid-Ouachita Pottery as Cahinnio Caddo. The 
Arkansas Archeologist IV (8):1-12. Fayetteville, Arkansas. Reprint of an article that appeared in 
Texas Archeological and Paleontological Society Bulletin 16:98-116, 1945. 
 
Hodges, T. L.; Hodges, Mrs. 
1964  The Watermelon Island Site in Arkansas. The Arkansas Archeologist III (3):9-16. 
Fayetteville, Arkansas. Reprint of an article that appeared in Texas Archeological and 
Paleontological Society Bulleting 15:66-79, 1943. 



 

 

 

 
Schambach, Frank F. 
1998  Pre-Caddoan Cultures in the Trans-Mississippi South. Arkansas Archeological Survey 
Research Series 53. Fayetteville, Arkansas. 
 
Scholtz, James A.; Davis, Hester A. 
1967  Five Auxiliary Techniques for Archeological Research plus A Compilation of Radiocarbon 
Dates for Arkansas Through 1966. Special Publication for Life, Contributing, and Supporting 
Members. Arkansas Archeological Society. Fayetteville, Arkansas. 
 
Suhm, Dee Ann; Krieger, Alex D.; Jelks, Edward B. 
1954  An Introductory Handbook of Texas Archeology. Bulletin of The Texas Archeological 
Society 25:209-211. Austin, Texas. 
 
Suhm, Dee Ann; Jelks, Edward B. 
1962  Handbook of Texas Archeology: Type Descriptions. The Texas Archeological Society and 
the Texas Memorial Museum. Austin, Texas. 
 
Wood, W. Raymond 
1963  The Denham Mound: A Mid-Ouachita Focus Temple Mound in Hot Spring County, 
Arkansas. University of Arkansas Museum Anthropology Series 1. Fayetteville, Arkansas. 
 

Social Hill Phase 
 
Early, Ann M. 
1974  Winter Archeology, the Hedges Site, 3HS60. Field Notes 116:3-5. Arkansas Archeological 
Society. Fayetteville, Arkansas. 
 
Early, Ann M. 
1993  Caddoan Saltmakers. Arkansas Archeological Survey Research Series 43. Fayetteville, 
Arkansas. 
 
Schambach, Frank F. 
1998  Pre-Caddoan Cultures of the Trans-Mississippi South. Arkansas Archeological Survey 
Research Series 53. Fayetteville, Arkansas. 
 

Deceipher Phase 
 
Burnett, Barbara A. 
1993  Bioarcheology and Adaptive Efficiency of Arkansas Populations. In Caddoan Saltmakers in 
the Ouachita Valley, edited by Ann M. Early, pp.169-222. AAS Research Series 43. Fayetteville, 
Arkansas. 
 
Early, Ann M., editor 
1993  Caddoan Saltmakers in the Ouachita Valley: The Hardman Site. Arkansas Archeological 
Survey Research Series 43. Fayetteville, Arkansas. 
 
Early, Ann M. 
2000a  Ceramics. In Data Recovery at the Helm Site, by Robert H. Lafferty III, et al. Report 
Submitted to the Arkansas Highway and Transportation Dept. Little Rock, Lowell, Arkansas. 
 
Early, Ann M. 
2000b  The Caddos of the Trans-Mississippi South. In Indians of the Greater Southeast, edited by 
Bonnie G. McEwan, pp.122-141. University of Florida Presses. Gainesville, Florida. 
 



 

 

 

Rush Creek Phase 
 
Braun, David P. 
1987  Coevolution of Sedentism, Pottery Technology, and Horticulture in the Central Midwest, 
200 B.C.-A.D.600. In Emergent Horticultural Economies of the Eastern Woodland, edited by 
William Keegan, pp.153-181. Southern Illinois University at Carbondale Center for Archeological 
Investigations Occasional Paper 7. Carbondale, Illinois. 
 
Bray, Robert T. 
1956  The Culture-Complexes and Sequence at the Rice Site (23SN200), Stone County, 
Missouri. The Missouri Archaeologist 18(1-2): 46-134. Columbia, Missouri. 
 
Brown, James A. 
1984  Prehistoric Southern Ozark Marginality: A Myth Exposed. Missouri Archaeological Society 
Special Publication 6. Columbia, Missouri. 
 
Brown, James A. 
1989  The Beginnings of Pottery as an Economic Process. In What's New: A Closer Look at the 
Process of Innovation, edited by S.E. van derLeeuw and R. Torrence, pp.203-224. Unwin Hyman, 
London. 
 
Early, Ann M. 
2002  Arkansas Prehistory and History in Review. Field Notes 304:4. Arkansas Archeological 
Society. Fayetteville, Arkansas. 
 
Guendling, Randall; Sabo III, George; Guccione, Margaret J.; Dunavan, Sandra; Scott, Susan. 
1992  Archeological Investigations at 3MR80-Area D in the Rush Development Area, Buffalo 
National River, Arkansas Vol.II. National Park Service Southwest Cultural Resources Center, 
Professional Papers 50. Santa Fe, New Mexico. 
 
Harrington, Mark R. 
1960  The Ozark Bluff-Dwellers. Museum of the American Indian, Heye Foundation. Indian Notes 
and Monographs 12. New York, New York. 
 
House, John H. 
1972  Flat-based Shell-Tempered Pottery in the Ozarks: A Preliminary Discussion. The Arkansas 
Archeologist 19:44-49. Fayetteville, Arkansas. 
 
Kelley, J. Charles 
1947  The Lehman Rock Shelter: A Stratified Site of the Toyah, Uvalde, and Round Rock Foci. 
Bulletin of the Texas Archaeological and Paleontological Society 18:115-28. Austin, Texas. 
 
Kreisa, Paul P.; Edging, Richard; Ahler, Steven R. 
2002  The Woodland Period in the Northern Ozarks of Missouri. In The Woodland Southeast, 
edited by David G. Anderson and Robert C. Mainfort, Jr., pp.113-33. The University of Alabama 
Press. Tuscaloosa, Alabama. 
 
Lynott, Mark J. 
1989  An Archeological Evaluation of the Gooseneck and Owls Bend Sites. Occasional Studies in 
Anthropology 23. National Park Service, Midwest Archeological Center. Lincoln, Nebraska. 
 
Sabo III, George; Guendling, Randall L.; Limp, W. Frederick; Guccione, Margaret J.; Scott, Susan 
L.; Fritz, Gayle J.; Smith, Pamela A. 
1990  Archeological Investigations at 3MR80-Area D in the Rush Development Area, Buffalo 
National River, Arkansas Vol.I. Southwest Cultural Resources Center, Professional Papers 
No.38. Santa Fe, New Mexico. 



 

 

 

 
Spears, Carol S.; Taylor, Robert A.; Dixon, John C.; Rogers, Susan D. 
1986  Archeological Testing, Geomorphic Interpretations, and History of the Rush Development 
Area in the Buffalo National River, Marion County, Arkansas. SPEARS Report No.86-3. West 
Fork, Arkansas. 
 
Suhm, Dee Ann; Krieger, Alex D.; Jelks, Edward B. 
1954  An Introductory Handbook to Texas Archaeology. Bulletin of the Texas Archaeological 
Society 25. Austin, Texas. 
 
Willey, Gordon R.; Phillips, Philip 
1958  Method and Theory in American Archaeology. The University of Chicago Press. Chicago, 
Illinois. 
 

Plum Bayou Phase 
 
Bennett, Jeyne 
1980  Application and Standardization of the Methods of Petrographic Identification, Micrometry, 
and Stereology for Ceramic Technological Studies: Qualitative and Quantitative Analysis Using 
the Toltec Site, 3LN42, Grog-tempered Ceramics. Fayetteville, Arkansas. Unpublished Master's 
thesis. Department of Anthropology, University of Arkansas. 
 
Brown, James A. 
1996  The Spiro Ceremonial Center, the Archaeology of Arkansas Valley Caddoan Culture in 
Eastern Oklahoma, Memoir No.29. Museum of Anthropology. University of Michigan, Ann Arbor, 
Michigan. 
 
Davis, Hester 
1966  Nine Days at the Toltec Site. Field Notes 20:2-6. Arkansas Archeological Society. 
Fayetteville, Arkansas. 
 
Fritz, Gayle; Powell, Gina 
1998  Appendix B: Seeds, Plants, and Cultigens. In Toltec Mounds and Plum Bayou Culture: 
Mound D Excavations by M.A. Rolingson. Research Series 54. Arkansas Archeological Survey. 
Fayetteville, Arkansas. 
 
Hemmings, E.T.; House, J.H., editors 
1985  The Alexander Site, Conway County, Arkansas. Research Series 24. Arkansas 
Archeological Survey. Fayetteville, Arkansas. 
 
Hoffman, Robert W. 
1982  Animal Resource Exploitation Patterns at the Toltec Site: A Zooarcheological Study of the 
Mound D sample. Fayetteville, Arkansas. Unpublished Master's thesis. Department of 
Anthropology, University of Arkansas. 
 
Hoffman, Robert W. 
1998  The Faunal Material, In Toltec Mounds and Plum Bayou Culture: Mound D Excavations 
pp.84-94, by M.A. Rolingson. Research Series 54. Arkansas Archeological Survey. Fayetteville, 
Arkansas. 
 
Hoffman, Teresa 
1982  Chipped Stone Tool Manufacturing Processes in Mound D at the Toltec Mounds Site 
(3LN42). Fayetteville, Arkansas. Unpublished Master's thesis. Department of Anthropology, 
University of Arkansas. 
 
Hoffman, Teresa 



 

 

 

1998  The Lithic Assemblage. In Toltec Mounds and Plum Bayou Culture: Mound D Excavations 
by M.A. Rolingson, pp.54-79. Arkansas Archeological Survey Research Series 54. Fayetteville, 
Arkansas. 
 
House, John H. 
1975  Summary of Archeological Knowledge Updated with Newly-Gathered Data. In The Cache 
River Archeological Project: An Experiment in Contract Archeology, assembled by M.B. Schiffer 
and J.H. House, pp.153-62. Arkansas Archeological Survey Research Series 8. Fayetteville, 
Arkansas. 
 
House, John H. 
1996  East-Central Arkansas. In Prehistory of the Central Mississippi Valley, edited by C.H. 
McNutt, pp.137-154. The University of Alabama Press. Tuscaloosa, Alabama. 
 
Moore, Clarence B. 
1908  Certain Mounds of Arkansas and Mississippi, Part I., Mounds and Cemeteries of the Lower 
Arkansas River. Journal of the Academy of Natural Sciences of Philadelphia, 13:481-563. 
Philadelphia, Pennsylvania. 
 
Moore, Clarence B. 
1910  Antiquities of the St. Francis, White and Black Rivers, Arkansas. Journal of the Academy of 
Natural Sciences of Philadelphia 14:255-364. Philadelphia, Pennsylvania. 
 
Nassaney, Michael S. 
1982  Late Prehistoric Site Configuration in the Southeast: Designing a Sampling Strategy for the 
Toltec Mounds Site. Fayetteville, Arkansas. Unpublished Master's thesis. Department of 
Anthropology, University of Arkansas. 
 
Nassaney, Michael S. 
1992a  Experiments in Social Ranking in Prehistoric Central Arkansas. Ann Arbor, Michigan. 
Ph.D. dissertation. Department of Anthropology. University of Massachusetts, Amherst. 
 
Nassaney, Michael S. 
1992b  Communal Societies and the Emergence of Elites in the Prehistoric American Southeast. 
In Lords of the Southeast: Social Inequality and the Native Elites of Southeastern North America, 
ed. By A.W. Barker and T.R. Pauketat. Archaeological Papers: 3:111-133. American 
Anthropological Association. Arlington, Virginia. 
 
Nassaney, Michael S. 
1994  The Historical and Archaeological Context of Plum Bayou Culture in Central Arkansas. 
Southeastern Archaeology 13(1):36-55. 
 
Nassaney, Michael S. 
1996  The Contributions of the Plum Bayou Survey Project, 1988-1994, to the Native Settlement 
History of Central Arkansas. The Arkansas Archeologist 35:1-50. Fayetteville, Arkansas. 
 
Palmer, Edward 
1917  Arkansas Mounds. Arkansas Historical Association Publications 4:390-448. Fayetteville, 
Arkansas. 
 
Phillips, Philip 
1970  Archaeological Survey in the Lower Yazoo Basin, Mississippi, 1949-1955. Peabody 
Museum of Archaeology and Ethnology Papers 60. Harvard University, Cambridge, 
Massachusetts. 
 
Rolingson, Martha Ann 



 

 

 

1980  Toltec Mounds Research Project. The Arkansas Archeologist 21:35-56. Fayetteville, 
Arkansas. 
 
Rolingson, Martha Ann 
1982a  Public Archeology: Research and Development of the Toltec Mounds Site. In Arkansas 
Archeology in Review, edited by N.L. Trubowitz and M.D. Jeter, pp 45-75. Arkansas 
Archeological Survey Research Series 15. Fayetteville, Arkansas. 
 
Rolingson, Martha Ann 
1982b  The Toltec Mounds Site and Research Program. In Emerging Patterns of Plum Bayou 
Culture: Preliminary Investigations of the Toltec Mounds Research Project, edited by M.A. 
Rolingson, pp 1-10. Arkansas Archeological Survey Research Series 18. Fayetteville, Arkansas. 
 
Rolingson, Martha Ann 
1982c  The Concept of Plum Bayou Culture. In Emerging Patterns of Plum Bayou Culture: 
Preliminary Investigations of the Toltec Mounds Research Project, edited by M.A. Rolingson, pp. 
60-63. Arkansas Archeological Survey Research Series 18. Fayetteville, Arkansas. 
 
Rolingson, Martha Ann 
1983  1982 Excavations at Toltec Mounds State Park. Field Notes 191 3:7. Arkansas 
Archeological Society. Fayetteville, Arkansas. 
 
Rolingson, Martha Ann 
1990  The Toltec Mounds Site, A Ceremonial Center in the Arkansas River Lowland. In the 
Mississippian Emergence, edited by B.D. Smith, pp. 27-49. Smithsonian Institution Press, 
Washington D.C. 
 
Rolingson, Martha Ann 
1992  Excavations of Mound S at the Toltec Mounds Site, Preliminary Report. The Arkansas 
Archeologist 31:1-30. Fayetteville, Arkansas. 
 
Rolingson, Martha Ann 
1998  Toltec Mounds and Plum Bayou Culture: Mound D Excavations. Arkansas Archeological 
Survey Research Series 54. Fayetteville, Arkansas. 
 
Rolingson, Martha Ann 
2002  Plum Bayou Culture of the Arkansas-White River Basin. In The Woodland Southeast, 
edited by D.G. Anderson and R.C. Mainfort, Jr., pp. 44-65. The University of Alabama Press. 
Tuscaloosa, Alabama. 
 
Scholtz, James A. 
1991  Investigations at the Roland Site. The Arkansas Archeologist 30:7-56. Fayetteville, 
Arkansas. 
 
Smith, Christopher 
1993  The Analysis of Plant Remains from Mound S at the Toltec Site. St. Louis, Missouri. 
Unpublished Master's thesis. Department of Anthropology, Washington University. 
 
Smith, Christopher 
1996  Analysis of Plant Remains from Mound S at the Toltec Mounds Site. The Arkansas 
Archeologist 35:51-76. Fayetteville, Arkansas. 
 
Stewart-Abernathy, Judith C. 
1982  Ceramic Studies at the Toltec Mounds Site: Basis for a Tentative Cultural Sequence. In 
Emerging Patterns of Plum Bayou Culture: Preliminary Investigations of the Toltec Mounds 
Research Project, edited by M.A. Rolingson, pp. 44-53. Arkansas Archeological Survey Research 



 

 

 

Series 18. Fayetteville, Arkansas. 
 
Stewart-Abernathy, Judith C. 
1985  Ceramics and Clays at the Toltec Mounds Site (3LN42): A Test of X-ray Diffraction 
Analysis to Differentiate Local and Nonlocal Ceramics on a Regional Basis. Fayetteville, 
Arkansas. Unpublished Master's thesis. Department of Anthropology, University of Arkansas. 
 
Thomas, Cyrus 
1894  Report on the Mound Explorations of the Bureau of Ethnology. 12th Annual Report of the 
Bureau of Ethnology, 1890-1891:17-742. Washington, D.C. 
 
Waddell, David B.; House, John H.; King, Francis B.; Colburn, Mona L.; Marks, Murry K. 
1987  Results of Final Testing for Significance at the Ink Bayou Site (3PU252), Pulaski County, 
Arkansas. Fayetteville, Arkansas. Report prepared for the Arkansas Highway and Transportation 
Department by the Arkansas Archeological Survey. 
 
Willey, Gordon R.; Phillips, Philip 
1958  Method and Theory in American Archaeology. The University of Chicago Press. Chicago, 
Illinois. 
 

Kent Phase 
 
Anderson, David G. 
1999  Archaeology in the L'Anguille River Basin, Northeast Arkansas: Large-Scale Survey in the 
Southeast. In Arkansas Archaeology: Essays in Honor of Dan and Phyllis Morse, edited by 
Robert C. Mainfort and Marvin D. Jeter, pp. 65-95. University of Arkansas Press. Fayetteville, 
Arkansas. 
 
Brown, James A.; Kerber, Richard A.; Winters, Howard D. 
1990  Trade and the Evolution of Exchange Relations at the Beginning of the Mississippian 
Period. In The Mississippian Emergence, edited by Bruce D. Smith, pp. 251-280. Smithsonian 
Institution Press, Washington D.C. 
 
Connaway, John M. 
1984  The Wilsford Site (22-Co-516), Coahoma County, Mississippi: a Late Mississippi Period 
Settlement in the Northern Yazoo Basin of Mississippi. Archaeological Reports, Mississippi 
Department of Archives and History 14. Jackson, Mississippi. 
 
Harcourt, James 
1993  Archeological Monitoring of Construction Activities within the Brickeys Prison Site 
(3LE249): A Late Woodland and Mississippian Site in Lee County, Arkansas. Fayetteville, 
Arkansas. Report submitted to Arkansas Department of Correction by Arkansas Archeological 
Survey Sponsored Research Program. 
 
House, John H. 
1991  Monitoring Mississippian Dynamics: Time, Settlement and Ceramic Variation in the Kent 
Phase, Eastern Arkansas. Carbondale, Illinois. Ph.D. dissertation. Southern Illinois University. 
 
House, John H. 
1993  Dating the Kent Phase. Southeastern Archaeology 12:21-32. 
 
House, John H. 
1995a  Excavations at the Clay Hill and Kent Sites, Lee County, Arkansas. The Arkansas 
Archeologist 34:1-60. Fayetteville, Arkansas. 
 
House, John H. 



 

 

 

1995b  Mississippian Farmstead Testing in the Lower St. Francis Basin, Spring 1995. Arkansas 
Archeological Society Field Notes 266:7-11. Fayetteville, Arkansas. 
 
House, John H. 
1999  A Radiocarbon Date from Mound Cemetery. Arkansas Archeological Society Field Notes 
286:3-4. Fayetteville, Arkansas. 
 
House, John H.; House, Rebecca B. 
1987  Investigating Early Mississippi Period Occupation in the Lower St. Francis Basin, Eastern 
Arkansas. In The Emergent Mississippian: Proceedings of the Sixth Mid-South Archaeological 
Conference June 6-9, 1985, edited by Richard A. Marshall, pp. 122-136. 
 
Koldehof, Brad 
1987  The Cahokia Flake Tool Industry: Socioeconomic Implications for Late Prehistory in the 
Central Mississippi Valley. In The Organization of Core Technology, edited by Jay K. Johnson 
and Carol A. Morrow, pp. 151-186. Westview Press. Boulder, Colorado. 
 
Lumb, Lisa Cutts; McNutt, Charles H. 
1988  Chucalissa: Excavations in Units 2 and 6, 1959-67. Occasional Papers, Anthropological 
Research Center, Memphis State University 15. Memphis, Tennessee. 
 
Mainfort, Robert C. Jr. 
2001  The Late Prehistoric and Protohistoric Periods in the Central Mississippi Valley. In 
Societies in Eclipse: Archaeology of the Eastern Woodland Indians, A.D. 1400-1700, edited by 
David S. Brose, C. Wesley Cowen, and Robert Mainfort, Jr., pp.173-189. Smithsonian Institution 
Press. Washington D.C. 
 
Moore, Clarence B. 
1910  Antiquities of the St. Francis, White and Black Rivers, Arkansas. Journal of the Academy of 
Natural Sciences of Philadelphia 14:255-364. Philadelphia, Pennsylvania. 
 
Moore, Clarence B. 
1911  Some Aboriginal Sites on the Mississippi River. Journal of the Academy of Natural 
Sciences of Philadelphia 14:366-476. Philadelphia, Pennsylvania. 
 
Morse, Dan F.; Morse, Phyllis A. 
1983  Archaeology of the Central Mississippi Valley. Academic Press. New York, New York. 
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